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Introduction Welcome

Welcome

SourceXpress is a waveform creation software application. With the various optional waveform modules,
you’re able to create a wide variety of digitally modulated signals and impairment waveforms.

SourceXpress is designed to interface seamlessly with AWG70000A Series arbitrary waveform generators,
either connected to a virtual generator or connected to an instrument.

Connected to a Virtual Generator. The default mode of operation is for SourceXpress to connect to a
Virtual AWG7000A series instrument, configured by you.

When connected to a virtual generator, SourceXpress provides a simulation of the the AWG70000A Series
instrument work space, allowing you access to all controls and settings as if you were working with
an actual instrument.

Because you can create as many virtual generators as you like, each with different configurations, you can
create all your waveforms, sequences, and setups specific to instrument types, all in the absence of an
instrument. Then when an instrument is available, you can simply recall your saved files.

Connected to an instrument. With SourceXpress installed on a networked PC, the software can scan the
network for a AWG70000A Series instrument and connect directly to the instrument. The interface of the
AWG70000A instrument is displayed in the SourceXpress application window, providing you access to
all instrument controls, directly from SourceXpress. (The instrument itself displays a message that it is
being externally controlled.)

You can remotely connect to multiple AWG70000A series instruments, and control them, one at a time,
via SourceXpress.

In addition, you can control an active generator via the instruments GPIB programming commands. You
must send the GPIB commands to SourceXpress and then SourceXpress passes the command to the active
generator. Refer to the instrument’s programming manual for instrument specific commands.

NOTE. Menus and controls of the selected active generator are not described in this help system. Refer
to the documentation for instrument type chosen.
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Introduction Documentation

B sourcoxpress =

File Connectivity Tools Windows Help

Connected Generators. —
\ Channel 1
Name

VirtualGen_AWG70002

Run | Continuous -

[ open Waveform (1) Channel2  Waveform 1 Amplitude | 500 mVpp

Name | Length |

Run | Continuous Coupled SR: [

Y

|
Variable workspace interface

This shaded area of the display is dependant on the type of
instrument selected as the active generator.

For operation of the active generator, refer to the
documentation for the instrument type.

Workspace interface

The workspace provided in SourceXpress is dependent on the chosen active generator, regardless of
whether it is a virtual generator or connected to an instrument.

For operating information about the controls of the displayed generator, refer to the documentation
available for the specific instrument.

All documentation is available on the Tektronix web site (www. Tektronix.com/manuals ).

Documentation

In addition to this application Help system, the following documentation is available for the software.
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Introduction Support information

All documentation is available on the Tektronix web site (www. Tektronix.com/manuals ).

To read about Use these documents

SourceXpress operation and user interface help  Access the SourceXpress application help from the Help menu for
information on all controls and elements on screen.
The SourceXpress help system is also available in PDF format, available
on the Tektronix web site.

SourceXpress programmer commands Access the SourceXpress programmer manual for the syntax of remote
commands.

This document is available in PDF format located in the program’s
installation folder and also available on the Tektronix web site.

Connected instrument operation and user For operation and interface help of a connected instrument, refer to the
interface help instrument’s documentation.

This is available with the instrument or on the Tektronix web site

Connected instrument programmer commands For programming information of a connected instrument, refer to the
instrument's documentation.

This is available with the instrument or on the Tektronix web site

Support information

Tektronix offers the following services in support of their products:

m  Technical Support. For application-related questions about a Tektronix product, contact us by
telephone or email ).

m  Service Support. For service-related questions about a Tektronix product, contact us by telephone

or email ).

Tektronix also offers extended warranty and calibration programs as options on many products. Contact
your local Tektronix distributor or sales office.
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Introduction Feedback

Feedback

Tektronix values your feedback on our products. To help us serve you better, please send any suggestions,
ideas, or other comments you may have regarding your instrument.

m  Direct your feedback to us by email at www.tek.com/home/mytek/survey .

Please be as specific as possible.

Recommended information to include
®m  [nstrument hardware, such as display and chassis type

B Application software version

Optional information

Your name, company, mailing address, phone number, and FAX number
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Orientation Elements of the display

Elements of the display

The main areas of the application window are shown in the following figure.

Note that the workspace area is not discussed in this document since it’s content is based on the type of
instrument selected as the active generator. For information about controls of the active generator, you can
download the instrument’s documentation from the Tektronix web site.

SourceXpress

Restore tools help
Menu bar Wf“"""’“ SEr
Open and

save tools  [[emes R
e

[FomeTrigA] [Fon:e'lligﬂl [(anoutputs ot | _ Functions |

(1) Channel 1 Waveform Amplitude | 500 mVpp

Connected Generators

Connected —
InStrumentS VirtualGen_AWG70002

Waveforms
and
sequences

Variable workspace interface

This shaded area of the display is dependant on the type of
instrument selected as the active generator.

For operation of the active generator, refer to the
documentation for the instrument type.

Play button

The play button starts and stops the waveform playout when SourceXpress is connected to an instrument
and the connected instrument is set to Active in the Connected Generators tab.

If a virtual generator is active (selected in the Connectivity tab), the Play button is not enabled.
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Orientation Menu bar

Menu bar

The Menu bar provides access to various actions.

File (see page 6) provides access to various open, save, and setup actions.

Connectivity (see page 8) provides access to add generators to the Connected Generators tab.

Tools (see page 9) allows you to hide pop-up error messages, forcing the errors to only show in the
Status bar at the bottom of the screen.

Windows (see page 10) allows you to collapse or expand the tabbed panels.

Help (see page 10) provides access to the SourceXpress User manual and information about SourceXpress.

File menu
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Orientation File menu
Item Description
Reset Default Setup Returns all settings of the active generator to the factory settings.

NOTE. The contents of the active generator’s Waveforms tab, Sequences tab,
and Captured Signal List are removed.

The contents of these lists of any connected instrument are not affected.

Recall Last Setup

Returns the active generator to the setup that was last accessed.

Open Setup... Opens a window to allow you to navigate to saved setup files. Opening a setup file
returns the active generator to the settings saved with the setup file. Waveforms
and/or sequences saved with the setup file are also restored, removing all existing
waveform and sequence files.

Save Setup... Saves the current settings as a setup file, allowing you to easily return the application

to a known setup. A windows Save As dialog box opens to the most recent location
accessed. Use this window to navigate to where you want to save the setup.

In the Save As window, you can choose to save the setup file (which includes all
waveforms and sequences) or save the setup file without the assets (which excludes
all waveforms and sequences).

File name: -

Save as type: |AWGT0000 Setup (*.awgx) -
AWGT0000 Setup (*.awg:

AWGT0000 Setup without assets (*.awgx) |

The factory location is C:\Program Files\Tektronix\SourceXpress\Samples.

NOTE. Signals listed in the Capture/Playback tab are not saved as part of the
setup file.

Open Waveform...

Opens a window to allow you to navigate to saved waveform files. Performs the
same actions as the Open Waveform button in the Waveforms tab, opening any of
the supported file types. Refer to Open File for a description of the actions taken
depending on the type of file being opened.

Open Sequence...

Opens a window to allow you to navigate to saved sequence files. To add a sequence
to the Sequences tab, select the Open Sequence button. This opens a Windows
dialog box that allows you to navigate to a saved sequence or setup file. If the
sequence or setup file is a valid file type, the sequences are added to the Sequences
tab and waveforms (used in the sequence) are added to the Waveforms tab.

Exit

Exits the application.
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Orientation Connectivity menu

Connectivity menu

Connectivity

Connect to Instrument...

Connect to Virtual Generator...

Item Description

Connect to Instrument... Displays the Available Instruments dialog screen.

Use the screen to select the instrument(s) you want to add to the Connected
Generators tab. This screen also allows you to search for, and add instruments to
the Connected Generators tab.

Refer to Connectivity (see page 15) for detailed information.
Connect to virtual Generator... Displays the Available Generators dialog screen.

Enables you create virtual generators and add selected virtual generators to the
Connected Generators tab.

Refer to Connectivity (see page 15) for detailed information.
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Orientation Tools menu

Tools menu

Toals

Disable error pop-ups

Licenses...

Item Description

Disable error pop-ups Enables or disables the pop-up error message windows. When disabled, error
messages only show in the status bar at the bottom of the screen.

The status bar shows the following icon to indicate the pop-up error messages are
hidden.

Yy

Licenses... Displays the License Management window. The License Management window
displays the installed plug-in licenses and access to install or return a license.

See Licensing (see page 43) for information about how licensing works.
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Orientation Windows menu

Windows menu

Windows

v Connected Generator List
v Waveform List

v Sequence List

Reset Window Layout

Item Description

Connected Generator List Displays or hides the Connectivity tab.

Waveform List Displays or hides the Waveforms tab.

Sequence List Displays or hides the Sequences tab.

Reset Window Layout Returns all application windows to their original location and display. For example, all
undocked tabs are returned to their original location and all closed tabs are reopened.
This is performs the same function as the icon in the Restore tools.

Help menu

10

Help & Support button: Help & Support provides links where you can obtain additional product help and
documentation. About my SourceXpress button: About my SourceXpress provides you with detailed
information about your instrument, such as installed options and software version. This information is
helpful when contacting Tektronix about your instrument. You can use the Copy Instrument Info button to
copy and paste the instrument information into another application such as an email program.

Item Description
User manual
Opens the application help system, same as the icon.
About SourceXpress... Provides you with detailed information about your application, such as the software

version. This information is helpful when contacting Tektronix about your instrument.

Use the Copy System Information button to copy and paste the instrument
information into another application such as an email program.
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Orientation

Open and save tools

Open and save tools

The Open and Save tools provide access to various open, save, and setup actions.

Open File allows you to open any of the supported file types. The action taken depends on
the file type opened.

B Setup files: Opening a saved setup file returns the instrument to the settings saved with the
setup file. Waveforms and/or sequences saved with the setup file are also restored, removing
all existing waveforms and sequences.

®  Waveform files: Opening a waveform file from the toolbar allows you to select one waveform
file at a time to load into the Waveforms tab. (Matlab files that contain more than one waveform
will have all waveforms loaded into the Waveforms tab.

See Adding a waveform (see page 23) for more information.

m  Sequence files: Opening a sequence file from the toolbar allows you to select one sequence
file at a time to load into the Sequence tab. If the sequence file contains subsequences, these
are also placed in the Sequences tab. All waveforms used in the sequence are loaded into
the Waveforms tab.

See Adding a sequence (see page 32) for more information.

A windows Open dialog box opens to most recent location accessed. Use this window to navigate
to your files.

The factory location is C:\Program Files\Tektronix\SourseXpress\Samples.

For more advanced options to add waveforms or sequences, use the Open icons located within
the Waveforms tab and Sequences tab panels.

Save Setup saves the current settings as a setup file, allowing you to easily return the active
generator to a known setup. A windows Save As dialog box opens to the most recent location
accessed. Use this window to navigate to where you want to save the setup.

In the Save As window, you can choose to save the setup file (which includes all waveforms
and sequences) or save the setup file without the assets (which excludes all waveforms and
sequences).

File name: -

Save as type: |AWGT0000 Setup (*.awgx) -
AWGT0000 Setup (*.awgx)

AWGT0000 Setup without assets (*.awgx) |

The factory location is C:\Program Files\Tektronix\SourceXpress\Samples.

NOTE. Signals listed in the Capture/Playback tab are not saved as part of the setup file.
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Orientation Restore tools

Restore tools

The Restore tools provide access to various actions to return the application to known setups and graphical

layout.
@&l e

Reset to Default Setup returns all settings of the active generator to the factory settings.

©

NOTE. The contents of the Waveforms tab, Sequences tab, and Captured Signal List are
removed.

The contents of these lists of any connected instrument are not affected.
Restore Last Setup returns the application to the setup that was last accessed.

Reset Window Layout returns all window panels (moved or undocked) to their original locations.

The User Manual button displays the help system.

caB

Screen interface features

12

The graphical user interface (GUI) is designed with some features that are only accessible via the right
and left mouse clicks.
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Orientation

Left mouse click

Screen interface features

Left mouse click on any control or setting to select or activate that control.

Right mouse click

Right mouse click on various areas, controls, and settings display a menu of available actions.

In some instances, a right mouse click is the only method to access some menus. For instance,
right click on one of the generators in the Connected Generators list to display the menu to activate,
disconnect, or display instrument properties.

Connected Generators

Mame

VirtualGen_AWG70002

Set to Active

Disconnect

Properties

Pull down lists Selections with a triangle incorporate a pull-down list. Left mouse click on the triangle to display
the list.
' — .T'I
| Qq -}
Connected Generators
o I
Drag and drop Use the left mouse click to drag a waveform from the Waveforms tab onto the waveform display

area. If a waveform is already attached to the channel, the waveform is replaced. If the previous
waveform was currently playing, the new waveform starts playing immediately.
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14

Orientation Screen interface features

Window resizing The various window panels can be adjusted in size where-ever two panels are divided. Use the
right mouse click to grab the 3 dot indicator and slide to increase or decrease its size.

q wee

fun = Continuous -
W) Channel 2 ‘Waveform_1
Ind|cates where panels

T i“““‘l“‘l‘

Wavefﬂrms

B Open Waveform

Name \ Length |

Wavelnrm 1 10

Undocking and Any tab can be undocked from the GUI. This allows you to reposition a tab to a new location
docking tabs or completely separate it from the main GUI. Use a left mouse click to grab a tab and slide it

to a new area. The docking icon displays that you can use to choose how you want to dock
reposition) the tab.

Use the Reset Window Layout button to return the display to the factory settings.
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Connectivity Connectivity

Connectivity

The Connectivity tab contains the list of generators that are currently connected to SourceXpress, whether
it’s a virtual generator or an instrument. You can connect to as many generators as you wish, but only
one can be active at a time.

At initial startup of the SourceXpress, one Virtual generater is connected by default, named
VirtualGen AWG70002. This is automatically set to be the active generator and displays a simulated
AWG70002A interface.

Virtual Generator. The default mode of operation is for SourceXpress to connect to the default virtual
generator, simulating an AWG70000A series instrument. You can create as many virtual generators you
like, each with different configurations. Once you create additional virtual generators, you can choose
which is the default virtual generator. (Right mouse click in the Available Virtual Generators screen to
select default generator.) When connected to a virtual generator, you can create all your waveforms,
sequences, and setups specific to instrument types, all in the absence of an instrument. Then when an
instrument is available, you can simple recall your saved files.

Connected to an instrument. With SourceXpress installed on a networked PC, SourceXpress can remotely
connect and control any AWG70000A instrument on the network. The interface of the AWG70000A
instrument is displayed in the SourceXpress application window, providing you access to all instrument
controls, directly from SourceXpress.

Connected Generators list

The Connectivity tab contains your list of available generators that SourceXpress is currently connected
with. You can connect to as many generators as you wish (virtual generators and instruments), but you can
only have one active at a time.

NOTE. All instruments appearing in the Connected Generators list are reserved by SourceXpress and their
instrument displays will indicate that it is being externally controlled. Anyone can regain control of the
instrument directly from its display, or you can remove it from the Connected Generators list. If someone
regains control of a connected instrument from the instrument display, the instrument is removed from

the Connected Generators list.
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Connectivity Connected Generators list

16

Quick instrument [ Q l
search L
Connected Generators
Acti ¢ Narne | Type | Connected
c. W? %eTjra or VirtualGen AWGT0002  Virtual AWG70000 virtual
is in bo e
typ VirtualGen AWG70001  Virtual AWG70000 generators
AWGT0001A AWGT0000
Connected
AWGT0002A AWGT0000 instruments

At initial startup of the application, one Virtual generated is created by default named
VirtualGen  AWG70002. This is automatically set to be the active generator and displays a simulated
AWG70002A interface.

Virtual Generators

You can create as many virtual instruments you like, each with different configurations. Use the
Connectivity > Connect to Virtual Generator... menu. When connected to a virtual instrument, you can
create all your waveforms or sequences, create setups specific to instrument types, all in the absence of an
instrument. Then when an instrument is available, you can simple recall your saved files.

Connect to instruments

With SourceXpress installed on a networked PC, SourceXpress can remotely connect and control any
AWG70000A instrument on the network. The interface of the AWG70000A instrument is displayed in
the SourceXpress application window, providing you access to all instrument controls, directly from
SourceXpress.

Quick instrument search/connect

The connectivity tab provides a window for you to directly enter the computer name (hostname) or IP
address of a networked instrument you wish to connect to.

You can obtain the correct hostname, go to the target instrument, select Computer > Properties and note the
computer name.

This method bypasses the search mechanism found in the menu Connectivity > Connect to Instrument...
Selecting the active generator

From the Connectivity tab, you select which instrument you want to access, regardless if it’s a virtual
generator or a connected instrument. Making the generator active brings its display into view.
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Connectivity Connect to a virtual generator

There are two methods to make a generator active:
B Double click on the generator.
®m  Right-mouse click on the generator and select Set to Active from the pop-up window.

Next to the name of each generator, the Type of generator is displayed to help identify instruments from
virtual generators.

Right-click menu operations

Right mouse click on any generator name displays a menu of actions.

Set to Active

Disconnect

Properties

Item Description

Set to Active Sets the selected generator to the active generator, bringing its controls into view.
Only one active generator is allowed at a time.

Disconnect Disconnects the selected generator from SourceXpress and is removed from the
Connected Generators list.

NOTE. You cannot disconnect the default virtual generator.

Properties Displays the system information about the selected generator.

Connect to a virtual generator

To connect to a virtual generator, you must select the menu Connectivity > Connect to Virtual Generator...

This displays the Available Virtual Generators window.
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Connectivity Connect to a virtual generator

18

m Available Virtual Generators EI@
Select virtual generators to connect
MName | Maodel | Options |
VirtualGen AWG70001_1  AWGT70001 01,150, 03
VirtualGen_AWG70001 AWGT0001 01, 150, 03, AC

*The default generator that will be connected on startup

From this list, you can select one (or more) virtual generators to add to the Connected Generators (see

page 15) list.

The default virtual generator is indicated with an asterisk (*). The default generator is the virtual generator
that is initially connected to upon application start-up.

Not all controls are enabled
When a virtual generator is the active generator, not all controls are active since it is a virtual generator.

For example, controls such as the Play/Stop button, Force Trigger buttons, Channel on/off buttons, and
others are not available.

Right-click menu operations

Right mouse click on any generator name displays a menu of actions.

Item Description

Set as Default Virtual Generator Defines the generator that is automatically connected to when the application is
started.

Remove Removes the generator name from the list.
You cannot remove the default generator but you can reassign which is the default
generator.
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Connectivity Connect to a virtual generator

Creating virtual generators

You can create additional virtual generators, each with its own set of properties, such as a two-channel or
single-channel instrument to simulate actual instrument you may connect to in the future.

From the Available Virtual Generators window, select Create Generator.

[ Create Virtual Generator EI@

Name | VirtualGen AWG70001_2

Models Options
AWG7OOOL Sample Rate
AWGT0002

® 150 - 50 Gsample/s
pl
B4 01 - Memary Expansion (2 to 16 Gpoint)

B4 03 - Sequencing

B2 AC - AC Amplifier and Attenuator

e

Item Description

Name Use to define a name for the generator you are creating.

By default, the name is given a base name of VirtualGen with the model type
appended to the name. If needed, the name is appended further with a numerical
value.

You can overwrite the Name field entirely by typing in a generator name.
NOTE. You cannot duplicate or overwrite an existing Virtual Generator name.
Models Choose the model you want to simulate

Options The options selections change depending on the model selected. This allows you to
only choose options appropriate for the selected model.
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Connectivity Connect to an instrument

Item Description

Create Creates the generator as defined, and adds the named generator to the Available
Virtual Generators window.

NOTE. This only creates the generator and it becomes available as another
generator to connect to.

You still must select any new generators in the Available Virtual Generators window
to connect to them (thus adding them to the Connected Generators list).

Cancel Exits out of the Create Virtual Generator window without creating any new generators.

Connect to an instrument

To connect to an instrument, use the menu Connectivity > Connect to Instrument... to display the Available
Instruments screen.

With SourceXpress installed on a networked PC, the software automatically scans the network for any
AWG70000A Series instruments.

NOTE. The auto discovery only discovers instruments on the same Subnet.

Select any (or all) instruments found and select OK to make a connection to them. The instrument will
appear in the Connected Generators list. If no instruments are found, you can modify how the search is
performed by selecting the Modify Search Criteria (see page 21) button.

NOTE. Once an instrument is connected to SourceXpress, its display is disabled. A message is displayed
indicating it is being remotely controlled. The connection can be disabled directly from the instrument s
screen by ending the remote session.

EA\railableInstruments EI@
Select instruments to connect [ Refresh l [ Modify Search Criteria l
MName |T}fpe |

Mo results found. Refresh or modify search critena to find instruments.

CK Cancel
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Connectivity Connect to an instrument

Item Description

Refresh A network search is typically performed each time you choose Connectivity >
Connect to Instrument. But this can be disabled from the search criteria screen.

Choose Refresh to scan the network for instruments.

Modify Search Criteria Opens the dialog screen to change search parameters.
See Modify Search Criteria (see page 21) for details.

OK Select any (or all) instruments in the generators listed, then select OK to establish
the connection and add them to the connected Generators list.

Cancel Closes the dialog screen without adding connecting to any generators.

Modify Search Criteria

With SourceXpress installed on a networked PC, the software can scan the network for any AWG70000A
Series instruments (on the same Subnet) and connect remotely to the instrument.

E Search Criteria EI@

| AWG 70000 © |

M Include in search

# Auto Discovery

Hostname l l [ Add to search

Search List
AWGT0002Q011
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Connectivity

22

Item

Connect to an instrument

Description

Auto Discovery

When checked, each time Connect to Instrument is selected from the Connectivity
menu, the application automatically initiates a search, looking for instruments on
the same Subnet.

NOTE. The instrument must be on the same subnet as the PC running the
SourceXpress application.

Hostname Enter the computer name (Hostname) or the IP address of a networked instrument
you wish to connect to.
NOTE. To obtain the correct hostname, go to the target instrument, select
Computer > Properties and note the computer name.
After entering the Hostname, select the Add to search button. This places the
hostname in the Search List.

Add to search Places the Hostname in the Search List.

Search List Stores a list of instruments to automatically search for each time a search is initiated.

Include in search

When checked, the AWG 70000 series instrument types are included in the automatic
search. Unchecking this will result in not finding any AWG70000 series instruments.

Search

Initiates a network search.

Close

Closes the dialog screen without initiating a search.
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Waveforms tab Waveforms tab

Waveforms tab

The Waveforms tab contains the waveforms available to assign to a channel. Right-mouse click on a
waveform to display a pop-up menu of tools to modify waveforms, assign a waveform to a channel, save,
remove waveforms, and view a waveform’s properties.

p
e
E Available with
Name | Length | Precompensation
{ Wave_1 24k Plug-in
$ Wave 2 24k Right mouse click <
Bwees | onEvaemT
= Wave 4 24k
5 Wave_5 24k

.

You can drag and drop a waveform from the Waveforms tab onto the channel’s graph area, assigning
that waveform to play on the channel.

If a Precompensation plug-in is installed, the Apply Corrections menu is available. This allows you to
navigate to a saved correction file and apply it to the selected waveform.

Adding a waveform

To add a waveform to the Waveforms tab, select the Open Waveform button. This opens a Windows
dialog box that allows you to navigate to a stored waveform, setup file, or sequence file. (You can load
waveforms contained in Setup files and sequence files.)

If the waveform is a valid waveform type, the waveform is added to the Waveforms tab. Once a waveform
is in the Waveforms tab, it can be assigned to a channel for playout. Click here to see the list of valid
waveform file types.

Valid file types Description
AWGKX file format Setup file created by Tektronix AWG70000A Series instruments or SourceXpress.
Setup files can contain multiple waveforms and multiple sequences.

NOTE. Opening a setup file from the Waveform List does not restore the instrument
settings, only the waveforms contained in the setup file are restored.

WEFMX file format Created by Tektronix AWG70000A Series instruments or SourceXpress.
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Valid file types

Adding a waveform

Description

AWG file format

Setup file created by Tektronix AWG5000 or AWG7000 Series instruments.

NOTE. The Tektronix AWG5000 or AWG7000 Series instruments had predefined
waveforms available for use.

Saved setup files that used predefined waveforms did not save the actual waveform
data with the setup, only the waveform name. Hence, importing setup files that
used predefined waveforms will not import the waveforms. To import these types of
waveforms, first copy and rename the predefined waveform, then save the setup file
before importing to the AWG70000A Series instruments.

\WFM file format

Created by Tektronix AWG5000/7000 Series instruments.
Created by Tektronix AWG400/500/600/700 Series instruments.
Created by Tektronix TDS/DPO/MSO/DSA Series instruments.

.ISF file formats

Created by Tektronix TDS/DPO/MSO/DSA Series instruments.

.PAT file formats

Created by Tektronix AWG400/500/600/700 Series instruments.

QT file format

Created by Tektronix RSA3000 Series instruments.

.TIQ file format

Created by Tektronix RSA6000/5000 Series, SPECMON Series ,MDO4000 Series
instruments. or SignalVu-PC.

.TFW file format

Created by Tektronix AFG3000 Series instruments.

TXT file format

Created by Tektronix AWG5000 or AWG7000 Series instruments.

.RFD file format

Created by Tektronix RFX100 RFXpress Advanced RF/IF/IQ waveform software.

.SXD file format

Created by Tektronix SDX100 SerialXpress high-speed serial data signals software.

.MAT file format

Matlab file type, Level 5 or Level 7.3.

.TMP file format

Midas BLUE file type.

.PRM file format

Midas BLUE file type.

With the Sequencing option (Option 03), the following files types are also valid waveform sources.

.SEQX file format

Sequence file created by Tektronix AWG70000A Series instruments or SourceXpress.

.SEQ file format

Sequence file created by Tektronix AWG400, AWG500, or AWG600 Series
instruments.

If selecting a file type containing multiple waveforms (AWGX, .MAT, .AWG, .SEQX), you are presented
with the Available Waveforms dialog box (see page 25) that lists all waveforms contained in the setup file.

You can load all the waveforms or select a subset of the waveforms.

NOTE. When opening an AWG70000A4 Series setup file (AWGX) from the Waveforms tab, only the
waveforms are extracted, instrument settings contained in the setup file are not restored. Use the File
> Open Setup... menu in the Menu bar (see page 11) to restore both the settings and waveforms from a

AWGX setup file.

If you want any of the waveforms (extracted from a setup file) to be available outside of the setup file,
select and save each individual waveform.

SourceXpress Printable Help Document



Waveforms tab

Adding a waveform

Available waveforms

% Available Waveforms
Select waveform(s) to open

[F=| BN [Ec)

Name ‘ Length‘ Date

Select all Unselect all ]

‘ Sampling Rate‘

Sine50_8Bits 50 4/18/2013 8:37:41 AM ---S/s

Sine50 48 8Bits 24k 4/18/2013 8:38:17 AM ---S/s

o | [ s

When adding an analog waveform file that exceeds the amplitude range of the instrument, you are
presented with the Importing waveform dialog screen (see page 25) to normalize (rescale) the waveform

while adding to the Waveforms tab.

Import waveform

I Importing Waveform

(+/-0.25V full scale)

Rescale

Scale to Max Amplitude

Max & Preserve Offset

Cancel

J
| J
| oonthessle |
| J

The selected waveforms may not match this instrument's amplitude range.

]

When adding a digital text (. TXT) waveform file, the Import Digital Waveform Text File (see page 26)
dialog box displays to specify the digital bit resolution of the file before the waveform is added to the

Waveforms tab.

Choose from the following:
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A

26

m 8 Bits (waveform + 2 markers): For 10 bit files that use 8 bits for data, and two bits for markers.
® 9 Bits (waveform + 1 marker): For 10 bit files that use 9 bits for data, and one bit for a marker.
10 bits: For 10 bit files without markers.

It’s important to know the details of your waveform before you import so you do not affect the integrity of
the waveform. For instance, selecting 10 bits for a waveform that is intended to use 8 bits for data and two
bits for markers will add the marker bits to the waveform data and markers will not be available.

Import digital waveform text file

e Import Digital Waveform Text File @

Resolution

{ 8 Bits (waveform + 2 markers) J

{ 9 Bits (waveform + 1 marker) J

{ 10 Bits (10-bit waveform, no markers) J

NOTE. If sequencing is available, waveforms are also added to the waveforms tab when loading a
sequence file or setup file that contains a sequence.

Multi-waveform select

Through the Open Waveform menu in the Waveforms tab, you can select multiple waveform files to load
into the waveform list at once.

To select a contiguous block of files, click the first file in the block. Then hold down the Shift key as you
click the last file in the block. This will select not only those two files, but everything in between.

To select multiple files that are not a contiguous block, click one file. Then hold down the Ctrl key while
you click each additional desired file.

If your selection includes sequence files or setup files, all waveforms saved with those file types are
loaded into the waveform list.

CAUTION. Loading groups of waveforms will overwrite any existing waveform of the same name in
the Waveforms tab without warning.
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NOTE. Multiple file selection is available via the Open Waveform menu. Loading waveforms from the
Open File menu (in the tool bar) or from the pull-down list in the graphical waveform area does not
support multiple file selection.

Saving a waveform

To save a waveform, right mouse click on a waveform and select Save or Save As. This opens a Windows
dialog box that allows you to navigate to a location to save the waveform.

Assign a waveform to a channel

To play a waveform, you need to assign it to a channel. This is true even for a single channel instrument.
There are several methods to assign a waveform to a channel.
®m  Drag a waveform from the Waveforms tab onto a channel’s plot area.

®  Right mouse click on a waveform name in the Waveforms tab and use the pop-up window to assign
it to a channel.

Modify Waveform
Modify Markers

Make a Copy

save ) 12k
Save As...

Rename Coupled

Assign to Channel 1
Channel 2
|“| 1

Remove All Illl ||| '\ |'I‘ I||| Iﬂ|| II I'| }ll III Illrl‘l |[III |II III

ll.'l II\ IUI |ulI ||I‘ || I| J|| I|L|I |I|I II J\I

Remove

Properties

®  Use the drop-down list in the channel’s plot area to assign the channel to play a waveform.

You can choose waveforms already loaded into the Waveforms tab or you can browse for waveform
files. Selecting a waveform by browsing, the waveform is added to the Waveforms tab and assigned
to the channel for playout.
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If Sequencing is available, you can also open a sequence type file and load any of the waveforms
that were saved with the sequence.

(@ Channel 1, Wave 1

125 mV Wave_1
Waveform List...
Browse for Waveform...

-125 mV - .
Sequence List...

0

Run ' Triggered Modify Waveform...

Modify Markers...

(D) Channel 2 Clit

Properties

You can select any waveform contained in the Waveform List to view its properties.

Select a waveform, touch and hold (or right mouse click) to display the waveform operations.

[ Open Waveform

Name ‘ Len e assign wave
Modify Waveform

Modify Markers

Make a Copy

Save

Save As...

Rename

Assign to

Remove

Remove All

Properties

Select Properties to display the Waveform Properties dialog screen.

28
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12 GS/s

The Waveform Properties dialog screen provides many details about the waveform that static (not able
to modify). But two items can be modified, allowing you to provide additional information about the
waveform.

®  Signal Format is used to indicate the format of the waveform.
= Undefined. Not specified.
- Real. Use this setting to describe a waveform containing data other than I or Q.
- I. Use this to describe a waveform containing I data.
= Q. Use this to describe a waveform containing Q data.

®  Recommended sample rate is typically defined by the waveform when it was created. You can
change the recommend sample rate as needed.
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Sequence tab Sequence tab

Sequence tab

NOTE. When connected remotely to an AWG70000A series instrument, the connected instrument must
have the Sequencing option installed.

The Sequences tab contains the available sequences. Right-mouse click on a sequence to display a pop-up
menu of tools to modify, rename, save, copy, and remove sequences.

To add a sequence to the list, see Adding a sequence (see page 32).

[E Open Sequence l

DTt

¥ Sequence_2

Right mouse click
on a sequence

¥ Sequence_3

¥ Sequence 4

Properties

From the Sequences tab you can assign the tracks to the output channels in various ways:

B Drag and drop a sequence from the Sequences tab directly on a channel’s graph area, always assigning
track 1 to channel one. On a two channel instrument, the second track of the sequence is assigned
to channel two.

B Display the tracks of a sequence and drag and drop a track directly on a channel’s graph area.

®  Use the pull-down menu of a sequence track and assign the track to a channel. (Single channel
instruments do not have a channel selection>)

[E} Open Sequence

W | : Sequence 2 assign waveform/sequence

: Track 1
: Track 2 Assign to Channel 1 r

i Tk 2 Channel 2
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Adding a sequence

For detailed information about how tracks are assigned to channels, refer to Assigning tracks to channels

(see page 34).

Adding a sequence

To add a sequence to the Sequences tab, select the Open Sequence button. This opens a Windows dialog
box that allows you to navigate to a saved sequence or setup file. If the sequence or setup file is a valid
file type, the sequences are added to the Sequence List and waveforms (used in the sequence) are added
to the Waveforms tab. Once a sequence is in the Sequences tab, a sequence track can be assigned to a
channel for playout. (See Assign a track to a channel.) (see page 34)

Valid sequence file types

Description

.SEQX file format

Sequence file created by Tektronix AWG70000A Series instruments or
SourceXpress.

AWGKX file format

Setup file created by Tektronix AWG70000A Series instruments or SourceXpress.
Setup files can contain multiple sequences and multiple waveforms.
NOTE. Opening a setup file from the Sequence List does not restore the

instrument settings, only the sequences contained in the setup file are restored
along with any waveforms used in the sequences.

AWG file format

Setup file created by Tektronix AWG5000 or AWG7000 Series instruments.

NOTE. The Tektronix AWG5000 or AWG7000 Series instruments had predefined
waveforms available for use.

Saved setup files that used predefined waveforms did not save the actual waveform
data with the setup, only the waveform name. Hence, importing setup files that
used predefined waveforms will not import the waveforms. To import these types of
waveforms, first copy and rename the predefined waveform, then save the setup
file before importing to the AWG70000A Series instruments.

NOTE. The Tektronix AWG5000 or AWG7000 Series instruments supported
subsequencing (using another sequence as a step in a sequence). Subsequences
are imported as another sequence and added to the Sequences list.

.SEQ file format

Sequence file created by Tektronix AWG400, AWG500, or AWG600 Series
instruments.

If selecting a setup type file containing multiple sequences, you are presented with the Available Sequences
(see page 33) dialog box that lists all sequences contained in the setup file. You can load all sequences or
select a subset of the sequences. Waveforms that are part of any sequence are added to the Waveforms tab.

32
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Available sequences

M Available Sequences (===
Select Sequence(s) to open

Name ‘Steps‘ Date ‘Sampling Ratt—:-‘

Sequence 2 10 9/9/2013 10:40:13 AM 25 GS/s
Sequence 3 4 9/9/2013 10:29:40 AM 25 GS/s

Sequence 4 15  9/9/2013 10:31:17 AM 25 GS/s

Unselected sequences that are subsequences of selected items will
also be opened.

Select all Unselect all } [ oK } [ Cancel

NOTE. When opening an AWG70000A Series setup file (AWGX) from the Waveforms or Sequences tabs,
only waveforms and sequences are extracted, instrument settings contained in the setup file are not
restored. Use the Open Setup in the File menu to restore the settings, waveforms, and sequences from a
AWGX setup file.

If you want any of the waveforms or sequences (extracted from a setup file) to be available outside of the
setup file, select and save each individual waveform.

Multi-sequence select

Though the Open Sequence menu in the Sequences tab, you can select multiple sequence files to load
into the sequence list at once.

To select a contiguous block of files, click the first file in the block. Then hold down the Shift key as you
click the last file in the block. This will select not only those two files, but everything in between.

To select multiple files that are not a contiguous block, click one file. Then hold down the Ctrl key while
you click each additional desired file.

c CAUTION. Loading a group of sequences will overwrite any existing sequence of the same name in the
Sequences tab without warning.

NOTE. Multiple sequence selection is not available from the Open File menu in the tool bar or from the
pull-down list in the graphical waveform area.
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Saving a sequence

To save a sequence, right mouse click and select Save or Save As. This opens a Windows dialog box that
allows you to navigate to a location to save the sequence.

Assigning tracks to channels

34

A sequence can consist of up to eight different tracks. (A minimum of one track is required). To play a
sequence track, you need to assign it to a channel. This is true even for a single channel instrument.

There are several methods to assign a sequence track to a channel. (See below for further information
regarding one channel and two channel instruments.)

®  Drag an entire sequence onto a channel’s plot area.
B Drag a track from a sequence onto a channel’s plot area.

B Right mouse click on a sequence track in the Sequences tab and use the pop-up window to assign
it to a channel.

[E? Open Sequence

WV | : Sequence 2 assign waveform/sequence

: Track 1

: Track 2 Assign to Channel 1 A

. 1o
: Track 3 Channel 2

®m  Use the drop-down list in the channel’s plot area to assign the channel to play a sequence track.
You can choose sequence tracks from sequences already loaded into the Sequences tab or you can
browse for sequence files. When browsing, you select the sequence file, and then select the track to
assign to the channel.
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T Available Tracks EI@

Select a sequence track

Name ‘ Steps| Date

]

Track 1 A
Track 2

oc | [

Assigning tracks on a one channel instrument
With a one channel instrument, the following actions occur when assigning a track to play on the channel:

B Ifyou drag and drop a sequence onto the channel’s graph area, Track 1 is assigned to the channel. This
is true regardless of how many tracks the sequence may contain.

B You can drag and drop (or assign) any track from any sequence onto the channel’s graph area.

Assigning tracks on a two channel instrument

With a two channel instrument, you have the option to play multiple tracks, either from the same sequence
or different sequences. You also have the option to play a sequence track on one of the channels while
playing a single waveform on the other.

The following describes the interactions between the two channels:

B You can drag and drop the entire sequence onto one of the channel’s graph area. This automatically
assigns Track 1 of the sequence to the channel.

- If the sequence has only one track, you can drag and drop the sequence to one or both channel’s
graph area and the single track will play on both channels.

- If the sequence has multiple tracks, you can drag and drop the sequence to either channel’s graph
area. In this case, Track 1 is assigned to Channel 1 and Track 2 is assigned to Channel 2. This is
the track assignment regardless of which channel you drag the sequence to.

- If playing tracks from the same sequence on both channels, the channels are coupled together.
This requires that the waveforms be of equal length for each step of the two tracks. In this case,
the Force jump to... buttons are coupled together. (Coupled Sequence is displayed on the Home
tab when tracks from the same sequence are assigned to both channels.)

B You can drag and drop (assign) a specific track from different sequences onto the channel’s graph area.
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This gives you the freedom to play any track from any sequence. Since the tracks are from different
sequences, the channels are not coupled together.

B You can play a sequence track on one channel while playing a waveform on the other channel.

Edit a sequence

You can select any sequence contained in the Sequences tab to modify it or create a new sequence based on
the existing sequence. Select any sequence in the list, right mouse click to display the sequence operations.
Selecting Modify sequence opens the sequence in the Sequences tab window for editing.

36 SourceXpress Printable Help Document



Waveform Plug-ins Waveform Plug-ins

Waveform Plug-ins

The Waveform Plug-in tab provides access to the available plug-in applications. Plug-ins provide
enhancements to the application software and are designed for installation into SourceXpress or
AWG70000A series arbitrary waveform generators.

Plug-in applications must be installed and licensed in SourceXpress in order to compile waveforms from
SourceXpress. This is true whether you are using a virtual generator or connected to an instrument.

A plug-in that has a floating license can be moved between any installation of the plug-in. Refer to
Licensing (see page 43) for information about how to use license files to enable or move a plug-in
application.

NOTE. SourceXpresss must have the license file (for a plug-in requiring a license) installed in the
SourceXpress application in order to use the plug-in.

A plug-in installed and licensed in a connected instrument is not available for use through SourceXpress
unless SourceXpress also has a license for the plug-in.

To view and install licenses, select Licenses... from the Tools menu to display the License Management

screen.
E License Management @

Host Id: SXP-9HIAHBFE4TNAT

Installed Licenses

Name Expires |
Install License l | Return License
To manage/obtain licenses, visit
hitpe/ . tek.col rodu roduct-license
Close

The Plug-in pull-down list displays the available plug-ins. (The example here shows that the Basic
Waveform and Multitone applications are installed.) As plug-ins are added, they appear in the Plug-in
pull-down list.

Waveform Plug-in

Plug-in: ]~ Compile Eﬂ [Reset Plug—inl [Help - |

Basic Waveform
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38

Plug-in applications have their own installation programs available for download from the Tektronix Web
site. Plug-in applications have their own documentation and help systems and are not described in this
document.

NOTE. The Basic Waveform application is provided as a standard plug-in and requires no license.

The Basic Waveform application is an integral part of the AWG70000A series generators. Refer to the
AWG70000A series help system for information about using the Basic Waveform application.

Waveforms created (compiled) using a plug-in are placed in the Waveforms tab. Use the Waveforms tab
to save or edit waveforms created by a plug-in.
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MATLAB waveform files

SourceXpress can read waveform files created with MATLAB (.MAT), a third party software application.
MATLAB files can contain multiple waveform data sets (including marker data) and can support files
greater than 2 GB. Waveforms created with MATLAB must meet the waveform requirements of the
target instrument.

SourceXpress supports the following levels of MATLAB files:
B  MATLAB level 5 can only support files less than 2 GB.
B MATLAB level 7.3 can support files larger than 2 GB.

This section defines the proper elements and conditions that the MATLAB file must be met to create an
AWG waveform file.

AWG MAT waveform elements
Waveform elements for an AWG MATLAB file format waveform must be contained in the same .mat file.
Each waveform will be grouped together by a trailing numerical value.

B For example - given the following elements: Waveform Name 1, Waveform Data 1,
Waveform Name 2, Waveform Data 2, Waveform M1 2, Waveform M2 2, two complete
waveforms can be formed:

= The first waveform will have the name identifier from Waveform Name 1 and the data that was
held in Waveform Data 1.

= The second waveform will have the name identifier from Waveform Name 2 and the data that
was held in Waveform Data 2. Additionally, the second waveform will have Marker 1 and
Marker 2 data.

Table 1: MATLAB required elements

Element Condition
Waveform_Name_# The MATLAB file must have the "Waveform_Name_#" specified.
The "Waveform_Name_#" must contain a string value denoting the waveform name.
Waveform_Data_# The AWG MATLARB file must have the "Waveform_Data_#" specified.
The "Waveform_Data_#" must contain an array of data values (representing waveform samples) in
one of the types: double, single, or UInt16.
Ideally, double and single should have values scaling from =1 to 1, and UInt16 should have values
ranging from 0 to 65535.
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Table 2: MATLAB optional elements

Element Condition
Waveform_M1_# The AWG MATLAB file can contain marker 1 data, having the "Waveform_M1_#" specified.

The "Waveform_M1_#" must contain a UInt8 array of marker values for the waveform's Marker
1. Only 1 and 0 are considered valid values.

The length of the marker array must match that of the AWG MATLAB file format waveform data
array length.

Waveform_M2_# The AWG MATLAB file can contain marker 2 data, having the "Waveform_M2_#" specified.
The "Waveform_M2_#" must contain a Ulnt8 array of marker values for the waveform's Marker
2. Only 1 and 0 are considered valid values.

The length of the marker array must match that of the AWG MATLAB file format waveform data
array length.

Waveform_Sam- The AWG MATLAB file can contain the sampling rate, having the "Waveform_Sampling_Rate_#"
pling_Rate_# specified.
The "Waveform_Sampling_Rate_#" must contain a "Double" value, indicating the waveform's
suggested sampling rate.

The specified sampling rate is the waveform's recommended sampling rate, but it will not directly
change any sampling rate settings of the instrument.

Waveform_Ampli- The AWG MATLAB file can contain the waveform amplitude, having the "Waveform_Amplitude_#"
tude_# specified.

The "Waveform_Amplitude_#" must contain a "Double" value, indicating the unique waveform's
suggested amplitude.

The specified amplitude is the waveform's recommended amplitude, but will not directly change
any amplitude settings of the instrument.

Waveform_Sig- The AWG MATLAB file can contain the waveform signal format having the
nal_Format_# "Waveform_Signal_Format_#" specified.

The "Waveform_Signal_Format_#" must contain a 'String' value indicating the unique waveform's
signal format.

Signal format indicates whether a Waveform is of the format type: Real, I, or Q.

MATLAB example

The following MATLAB coding example demonstrates how to create a MATLAB file that:
m creates a small, simple sinusoidal waveform with markers.

B saves the waveforms into separate files.

B saves the waveforms into a single file.

Table 3: MATLAB coding example

%% Create Sinusoid
X = 2399;
t=0:1x
baseWfm = sin(2*pi*1/x*t); % Generate Sine Wave
baseMarkers = uint8(square(2*pi*1/x*t,50));
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Table 3: MATLAB coding example (cont.)

%% Create Waveform 1 (Double)
Waveform_Name_1 = 'MyDoubleWfm';
Waveform_Data_1 = baseWfm; %already a double array
Waveform_M1_1 = baseMarkers; %already uint8 array
Waveform_M2_1 = baseMarkers;
save('AWG_Double', *_1', '-v7.3'); % MAT 7.3 Can save > 2GB
%% Create Waveform 2 (Single)
Waveform_Name_2 = 'MySingleWfm";
Waveform_Data_2 = single(baseWfm);
save('AWG_Float', ™_2', '-v7.3");
%% Save All Waveforms

save('All_Wfms.mat', 'Waveform_*', '-v7.3");
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Licensing overview

License files are used in SourceXpress to enable optional plug-ins and features.

A Licensing scheme is used to host your license files. The product license administration is through
Tektronix Asset Management System (TekAMS). TekAMS has an easy to use web based interface that
provides:

B Inventory of all the licenses in the company account
m  Ability to check out a license
B Ability to check in a license

The Tektronix Asset Management System is available athttp://www.tek.com/products/product-license .

To view and install licenses in SourceXpress, select Licenses... from the Tools menu to display the
License Management screen.

E License Management @

Host Id:  SXP-9HIAHBFE4TN4T
Installed Licenses

Name Expires |

Install License Return License

To manage/obtain licenses, visit
hitpe/ S tek.col roducts/product-license

Close

Generally, to properly install and activate a plug-in application, follow these steps.

1. Purchase a license from Tektronix. See How to purchase a license (see page 44).

2. Store the license file in a location available to the application. This can be on the instrument’s drive, a
USB flash drive, or any networked drive.

3. Obtain the plug-in installation file. Plug-in installation files are available for download from the
Tektronix web site.
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Licensing How to purchase a license

4. Install the plug-in application.

5. Install the license file. See How to install a plug-in license (see page 44).

How to purchase a license

Contact your local Tektronix Account Manager to purchase a plug-in license. After purchasing, you will
receive an email listing the licenses purchased. The email also contains the URL to the Tektronix Asset
Management System (TekAMS) that enables you to manage your licenses.

Floating Licenses provide the ability to move the license from an instrument or a personal computer to
another by checking in a license from an instrument or PC and checking it out to another.

The Tektronix Asset Management System (http://www.tek.com/products/product-license ) provides an
inventory of the license(s) in your account. If a license is a Floating license, it also enables you to check
out or check in the license.

There are three different types of licenses available for plug-ins:

License type Description

Node-Locked License ! This license is permanently assigned to a specific Hostid or product
model/serial number.

Node Locked Licenses provide your own copy of the application on
your instrument or personal computer.

Floating License This license can be moved between different Hostids or product
models.

Use the Tektronix Asset Management system to check in and check
out floating licenses.

Free Trial License This license has the same functionality as the floating license except
that it has a limited time period.

1 A Node-Locked license can be move up to two times after the initial installation to allow for operating system upgrades or other PC failures.

How to install a license

License files are used to enable optional applications.

NOTE. Applications may have been previously installed, but without a license, you cannot create
waveforms.

1. Select Licenses... from the Tools menu to display the License Management screen.
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2. Select the Install License button to display the license file selection
screen and browse to the location where you’ve stored the license
oo |

Organize » Share with + Burn New folder

= -

=

- Computer o MName Date modified Type
£, 0SDisk (C)
5 DVD RW Drive (D] [
e Removable Disk (E:)
9 mbd (\\us-bv-g03) |
S wee (VkekfsB) ())

[ D HOSTID_QHL79YTU34BCK_MTOMNENL-5501_ENTER.LIC  10/2/2015 2:26 PM  LIC File

ﬁle. 7 ]|+

3. Select the license file and select Open.

4. After the successful installation is finished, the name of the plug-in is listed along with the expiration
date and time.

Floating licenses display the expiration date for that application. The expiration date for a floating
license is defined when the license is checked out from the Tektronix Asset Management system.
After the license expires, the application is automatically disabled and the license on the TekAMS is
free to be assigned to a different host.
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Node locked license have no expiration date.

How to return a license

You can return a floating license to the Tektronix Asset Management System (TekAMS). After a floating
license is returned to the TekAMS, it becomes available to be assigned to a different host.

NOTE. Only floating licenses can be returned and reassigned to different hosts.

When assigning a license, you need to specify the host id or instrument and include the duration the feature
is to be enabled on the host. This is all done on the Tektronix Asset Management System (TekAMS) web
site. After the license expires, the feature is automatically disabled on the host and the license on the
TekAMS is free to be assigned to a different host.

1. Select Licenses... from the Tools menu. Under Installed Licenses, select the license to return and select
Return License. (A confirmation box is displayed in order to continue.)

ﬁ License Management IEI

Host Id: SXP-9HOAHBFEATMNAT
Installed Licenses

MName | Expires |

[ Install License ] [ Return License l

Te managefebtain licenses, visit
http:/www.tek.com/products/product-license

After confirming to continue, a license exit file will be created. You need to provide a name for the exit
file and browse to a location to save the license exit file.

[T Provide a name to save the exit license key. @
@\")4_ v Computer + Removable Disk (E) o \4, | [ search Removabte Disk (£ )

File name: -

Save as type: [License File(*.lic) ']

* Browse Folders Save l [ Cancel ]
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NOTE. The next step creates and saves the exit file. Once the exit file is created, the application will
immediately become nonfunctional (unable to compile).

2. Browse to the location where you would like to place the exit file (for example, a network drive or
a USB memory stick), and select Save to generate the exit file.

3. Login to your account on TekAMS (Tektronix Asset Management system) and upload the exit file.
Once the license is returned successfully, it can be re-assigned to a different host or instrument.
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